Motion on an Incline

INTRODUCTION

When you examined an object moving with constant velocity in introductory Activity 2, you learned two important points about the line of best fit to the graph of position vs. time:

1. The slope (rate of change) of the graph was constant, and gave the velocity of the object.
2. The intercept gave the initial position of the object.

In this experiment, you will examine a different kind of motion and contrast features of the position-time and velocity-time graphs with those you have studied earlier.

OBJECTIVES

In this experiment, you will

- Collect position, velocity, and time data as a cart rolls up and down an inclined track.
- Analyze the position vs. time and velocity vs. time graphs.
- Determine the best fit equations for the position vs. time and velocity vs. time graphs.
- Distinguish between average and instantaneous velocity.
- Use analysis of motion data to define instantaneous velocity and acceleration.
- Relate the parameters in the best-fit equations for position vs. time and velocity vs. time graphs to their physical counterparts in the system.

MATERIALS

- Vernier data-collection interface
- Logger Pro or LabQuest App
- Vernier Motion Detector
- Vernier Dynamics Track
- standard cart
- Motion Detector bracket
- books or blocks to elevate track

PRE-LAB INVESTIGATION

Elevate one end of the track. Place the cart at the lower end and give it a gentle push so that it moves up the track (without falling off) and returns to its starting position.

On the axes to the right, predict what a graph of the position vs. time would look like. Use a coordinate system in which the origin is on the left and positive is to the right.

Evaluation copy
Experiment 1

PROCEDURE

1. Connect the Motion Detector to the interface and start the data-collection program. Two graphs: position vs. time and velocity vs. time will appear in the graph window. For now, hide or remove the velocity vs. time graph. Later, during the analysis of data, you will add the v-vs-t graph back to your view.

2. Attach the motion detector to the bracket that will allow you to position it near one end of the track.

3. If your motion detector has a switch, set it to Track.

4. Elevate the end of the track opposite the motion detector as directed by your instructor.

5. Practice launching the cart with your finger so that it slows to a stop at least 50 cm from its initial position before it returns to the initial position.

6. Hold the cart steady with your finger at least 20 cm from the motion detector\(^1\), then zero the motion detector.

![Figure 1](image)

7. Begin collecting data, then launch the cart up the ramp. Be sure to catch it once it has returned to its starting position.

8. Repeat, if necessary, until you get a trial with a smooth position-time graph.

EVALUATION OF DATA

Part 1

1. Either print or sketch the position vs. time (x-t) graph for your experiment. On this graph identify:
   - Where the cart was rolling freely up the ramp
   - Where the cart was farthest from its initial position
   - Where the cart was rolling freely down the ramp

---

\(^1\) If you are using an older motion detector without a switch, the cart needs to be at least 45 cm from the detector.
2. In your investigation of an object moving at constant velocity, you learned that the slope of the $x$-$t$ graph was the average velocity of the object. In this case, however, the slope for any interval on the graph is not constant; instead, it is constantly changing. Based on your observations, sketch a graph of velocity vs. time corresponding to that portion of the $x$-$t$ graph where the cart was moving freely.

3. Now, view both the position vs. time and velocity vs. time graphs. Compare the $v$-$t$ graph to the one you sketched in Step 2.

4. Take a moment to think about and discuss how you could determine the cart’s velocity at any given instant.

5. If you are using Logger Pro, group the two graphs (x-axis), and turn on the Tangent tool for the $x$-$t$ graph and the Examine tool for the $v$-$t$ graph. (In LabQuest App, simply turn on the Tangent tool). Using either program, compare the slope of the tangent to any point on the $x$-$t$ graph to the value of the velocity on the $v$-$t$ graph. Write a statement describing the relationship between these quantities.

Part 2

1. Perform a linear fit to that portion of the $v$-$t$ graph where the cart was moving freely. Print or sketch this $v$-$t$ graph. Write the equation that represents the relationship between the velocity and time; be sure to record the value and units of the slope and the vertical intercept. On this $v$-$t$ graph identify:
   - Where the cart was being pushed by your hand
   - Where the cart was rolling freely up the ramp
   - The velocity of the cart when it was farthest from its initial position
   - Where the cart was rolling freely down the ramp

2. The slope of a graph represents the rate of change of the variables that were plotted. What can you say about the rate of change of the velocity as a function of time while the cart was rolling freely? In your discussion, you will give a name to this quantity. What is the significance of the algebraic sign of the slope?

3. Compare the value of your slope to those of others in the class. What relationship appears to exist between the value of the slope and the extent to which you elevate the track?

4. The vertical intercept of the equation of the line you fit to the $v$-$t$ graph represents what the velocity of the cart would have been at time $t = 0$ had it been accelerating from the moment you began collecting data. Suggest a reasonable name for this quantity. Now write a general equation relating the velocity and time for an object moving with constant acceleration

5. The position-time graph of an object that is constantly accelerating should appear parabolic. Use the Curve Fit function of your data analysis program to fit a quadratic equation to that portion of the $x$-$t$ graph where the cart was moving freely. Note the values of the $A$ and $B$ parameters in the quadratic equation. You will have to provide the units.

6. Compare these parameters (values and units) to the slope and intercept of the line used to fit the $v$-$t$ graph. Now write a general equation relating the position and time for an object undergoing constant acceleration.
EXTENSION

Try repeating the data collection with the same apparatus, but, this time, place the Motion Detector at the top of the track. Interpret your $x-t$ and $v-t$ graphs as you did before.

ANIMATED DISPLAY

If you are using Logger Pro, inserting an animated display gives you another tool to represent both the position and velocity of the cart at a number of instants during the experiment. Your instructor will show you how to set up the point display options for such a display.
Motion on an Incline

This lab is written with the assumption that the instructor will engage the students in discussions at critical junctures. These discussions can take place with the entire class or with individual lab groups. The icon at left indicates where these discussions should occur.

The Microsoft Word files for the student pages can be found on the CD that accompanies this book. See Appendix A for more information.

OBJECTIVES

In this experiment, the student objectives include

- Collect position, velocity, and time data as a cart rolls up and down an inclined track.
- Analyze the position vs. time and velocity vs. time graphs.
- Determine the best fit equations for the position vs. time and velocity vs. time graphs.
- Distinguish between average and instantaneous velocity.
- Use analysis of motion data to define instantaneous velocity and acceleration.
- Relate the parameters in the best-fit equations for position vs. time and velocity vs. time graphs to their physical counterparts in the system.

During this experiment, you will help the students

- Distinguish between average and instantaneous velocity.
- Recognize that instantaneous velocity is approximately the average rate of change in the position vs. time graph over a very small time interval.
- Define the instantaneous velocity as the slope of the tangent line at a point on the position vs. time graph.
- Recognize that an acceleration vs. time graph can be derived by examining the rate of change of a velocity vs. time graph.
- Relate the A and B parameters in a quadratic fit to a position vs. time graph to their physical counterparts in the system.

REQUIRED SKILLS

In order for student success in this experiment, it is expected that students know how to

- Zero a motion detector. This is addressed in Activity 2.
- Perform linear and curve fits to graphs. This is addressed in Activity 1.
- Manipulate graphs including deleting and adding graphs, grouping graphs in Logger Pro, and using the Tangent and Examine tools. This is addressed in Activity 3.
EQUIPMENT TIPS

While there are a number of ways one could collect suitable data for the analysis called for in this experiment, the best results are obtained by using a Dynamics Track, standard cart, and motion detector.

Attach the motion detector to the dynamics track using the bracket and position it so that it is at the lower end of the track. Make sure that the motion detector is set to Track mode. Students should remove objects (backpacks, books, etc.) from the area near the track so that they do not interfere with the signal from the motion detector.

PRE-LAB DISCUSSION

This experiment should be performed only after students have had the opportunity to explore the behavior of an object moving with constant velocity. Have students sketch position vs. time (x-t) and velocity vs. time (v-t) graphs for an object traveling with constant velocity as a review prior to exploring accelerated motion. Wait until the evaluation of data collected in this experiment to introduce such technical terms as instantaneous velocity and acceleration. As Arnold Arons recommends in Teaching Introductory Physics1, “Recognize that to be understood and correctly used, such terms require careful operational definition, rooted in shared experience and in simpler words previously defined; in other words, that a scientific concept involves an idea first and a name afterwards…”.

After demonstrating the motion of a cart up and down an elevated track, inform the students that they will be investigating the position vs. time and velocity vs. time behavior of this system. Allow them the opportunity to explore the behavior of the cart and ramp briefly, so they can make a prediction of the shape of the position vs. time graph, then distribute the lab instructions.

LAB PERFORMANCE NOTES

When the motion detector is connected to the data-collection interface and Logger Pro or LabQuest App is started, the default graph screen shows both position vs. time (x-t) and velocity vs. time (v-t) graphs. In order to gradually develop the concepts of instantaneous velocity and acceleration, instruct the students to hide the v-t graph. In Logger Pro this can be accomplished simply by dragging the corner of the x-t graph so that it covers the v-t graph. In LabQuest App, the students can choose to show Graph 1 only. Later, after they have made a prediction of the appearance of the v-t graph, they can show both graphs for the remainder of the analysis of data.

---

1 A. Arons, Teaching Introductory Physics, John Wiley & Sons, Inc, 1997
The connection between the acceleration and the incline of the track is more easily seen if you provide uniform thickness blocks to elevate the track. The sample data were collected using 2, 3 and 4 blocks that were ~1.5 cm thick.

By positioning the motion detector at the bottom of the track, the peak of the $x$-$t$ graph corresponds to the maximum height up the track, a result that is sensible to the students. Caution the student to catch the cart before it collides with the motion detector on its return to the starting position.

In the Extension, students place the motion detector at the top of the track and interpret the resulting $x$-$t$ and $v$-$t$ graphs.

**SAMPLE RESULTS AND POST-LAB DISCUSSION – PART 1**

The emphasis in Part 1 of the evaluation of data is qualitative, with students matching observed behavior with regions on the $x$-$t$ graph as shown in Figure 2.

![Figure 2  x-t graph using 2 blocks](image)

**Steps 2–4**

These questions provide an opportunity for a discussion that helps students make the distinction between average and instantaneous velocity. While the slope of the chord connecting two points for a large $\Delta t$ gives the average velocity, this value is not a particularly good descriptor of the velocity of the object at a given clock reading. Arons writes, “...one can move to cases of speeding up and slowing down with corresponding curvature of the graphs, examine chords on the graphs and their connection to average velocities over arbitrary time intervals, and finally go to the tangents to the graphs at different clock readings.” After students have sketched the $v$-$t$ graph, have them display both graphs. (In Logger Pro, choose Auto Arrange from the Page menu; on the LabQuest, choose Show All Graphs.)
**Experiment 1**

**Step 5**
The Tangent tool provides a way to compare the slope of the tangent to the $x-t$ graph to the value of the velocity at that instant.\(^2\) Such comparison should reinforce the concept that the slope of the tangent to the $x-t$ graph yields the instantaneous velocity of the cart. Contrast this with average velocity as the slope of the chord connecting the two points that define the interval over which the average is taken.

**SAMPLE RESULTS AND POST-LAB DISCUSSION – PART 2**
The emphasis in Part 2 of the evaluation of data is quantitative.

**Steps 1–2**
Have the students prepare presentations of their findings (whiteboard, chart paper, etc). These should include a sketch of the graph and the equation of their line of best fit.

![Figure 3 v-t graph using two blocks](image)

Students may have difficulty articulating the meaning of the units of the slope of their line of best fit to the $v-t$ graph. In this example, the slope indicates that the magnitude of the velocity of the cart changes by 0.318 meters per second each second. This is more easily seen when the units are expressed as m/s/s than as m/s\(^2\). Once they understand that the slope gives the rate of change of the velocity, you can introduce the term *acceleration* as the name we give to this quantity.

It is important to help students understand the significance of the sign of the acceleration. In this experiment the positive direction is away from the motion detector. During both parts of the motion, the change in velocity is in the negative direction.

---

\(^2\) You should point out that the software actually determines the slope of a chord for a very short time interval centered around the selected point on the curve. Logger Pro finds a weighted slope from 1, 2, 3 or more chords to the position-time graph.
**Note:** Discerning students might notice that the plot of the $v$-$t$ graph is not truly linear over the range of values depicted in Figure 3. This is due to the fact that the frictional force acts in different directions when the cart moves up and down the track. The effect is more noticeable when the track angle is low. Congratulate such students for their powers of observation, but advise them that, for now, they should ignore this discrepancy; they will re-visit this effect when they learn more about the force concept.

**Step 3**

If you have used uniform blocks to elevate one end of the track, students can readily see the relationship between the height and the value of the acceleration.

<table>
<thead>
<tr>
<th>Blocks</th>
<th>Acceleration (m/s/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>−0.318</td>
</tr>
<tr>
<td>3</td>
<td>−0.482</td>
</tr>
<tr>
<td>4</td>
<td>−0.639</td>
</tr>
</tbody>
</table>

**Step 4**

Since the cart started at rest and then was given a push up the track, students may find it troubling to call the vertical intercept value the initial velocity, $v_0$. Stress that the vertical intercept of the line of best fit gives the value of the initial velocity of the cart, had it been accelerating uniformly from time $t = 0$. So, for the line of best fit, the students can write the general equation $v = at + v_0$.

**Step 5**

Neither Logger Pro nor LabQuest App supplies units to the parameters in a curve fit to a graph.

![Figure 4 Curve fit to x-t graph](image)

Encourage students to use dimensional analysis to show that the units of $A$ must be m/s$^2$ and those of $B$ must be m/s.
**Experiment 1**

**Step 6**

By comparing the value of A to the slope of the $v$-$t$ graph (acceleration) for several trials, students should be able to conclude that A is half of the acceleration. This is an appropriate time to point out that units of acceleration (m/s/s) can be reduced to m/s$^2$. Furthermore, the B parameter is the same as the intercept to the $v$-$t$ graph (initial velocity). Once these connections have been made, students should be able to write the general equation for the position of an object moving with constant acceleration, $x = \frac{1}{2} a t^2 + v_0 t$.

**EXTENSION**

When the motion detector is placed at the top of the track, the cart reaches its minimum position when it has reached its farthest position up the track. The resulting $x$-$t$ graph is a top-opening parabola (Figure 5).

![Figure 5](image.png)

Ask students to interpret the sign of the velocity as it first approaches, then moves away from the motion detector. Challenge them to explain how the acceleration of the cart is positive while the cart is slowing down during the first half of its motion (Figure 6).
ANIMATED DISPLAY

Use of the Animated Display tool in Logger Pro allows students to produce a “motion map” to represent the motion of the cart during this experiment. Suggest that students first view the example given in the file “Exploring Animated Displays” by choosing Open from the File menu and then following the path: Experiments►Sample Data►Physics►Animated Display Vectors.

They should then choose Meter►Animated Display from the Insert menu to insert an animated display into their Logger Pro experiment file. Stretch the window horizontally, then double-click it to bring up the Animated Display Options window. Some sample settings are provided on the next page. Selecting Replay from the Analyze menu brings up the Replay control window. Judicious positioning of the windows allows one to view the trace of either graph at the same time as the animated display is drawn.

The settings shown in Figures 7 and 8 were used to produce the display in Figure 9.
Experiment 1

Figure 7

Figure 8

Figure 9  Animated display representing the velocity of the cart